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Y2 PIN 50MHz
Y2 G S Y2 FPGA i1 5
3 50M N1

SMA
SMA 7 i 5 SMA i 44 FPGA & [ %5 5
3 50MHZ N2

4.2 SRAM

O SRAM R T ISSI A A5 SRAM I1S61LV25616, Zw A 512k F47, HlE K,
256k*16bit 7. &£ 2 5H T SRAM [ ML .

& 2 SRAM EHIME (FhhRA)

SRAM IS61LV25616
SRAM & [l 4 5 SRAM % i144 | FPGA 4% fHigw 5
1 A0 AC9

2 Al AD10

3 A2 AB10

4 A3 AC10

5 A4 AD11

6 CE AC11

7 DO AB12
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D1 AD12
9 D2 AC12
10 D3 AALL
13 D4 AA12
14 D5 Y12
15 D6 AALO
16 D7 Y10
17 WE W11
18 A5 Y11
19 A6 U12
20 AT W12
21 A8 V13
22 A9 V14
23 A10 AF13
24 All AE13
25 Al12 AE12
26 Al3 AEL1
27 Al4 AF10
29 D8 AE10
30 D9 AF9
31 D10 AE9
32 D11 AF8
35 D12 AES8
36 D13 AF7
37 D14 AE7
38 D15 AA9
39 LB ADS
40 UB AC8
41 OE AB8
42 Al5 AD7
43 Al6 AC7
44 Al7 W8

43 FLASH

2 0aM L 17) Flash SR FH 1) /2 Spansion 22 %] ) XOR FLASH S29GL064M, %54 8Mbytes, 1] LA
T8 %) 32Mbytes. # 3 4H T Flash [ HEIL

% 3 Flash E 5T
FLASH S29GL064M

FLASH % 14w | FLASH & |4 FPGA % JHi4 =
1 A24 AE24
2 A23 AE25
Al6 AD25
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4 A15 AC25
5 Al4 AC26
6 A13 AB25
7 Al2 AB26
8 All AA25
9 A10 AA26
10 A9 Y25
11 A20 Y26
12 A21 W25
13 WE# W26
14 RESET# V25
15 A22 V26
16 Wp#/ACC U25
17 RY/BY# U26
18 A19 U24
19 A18 T25
20 A8 R25
21 A7 P24
22 A6 R24
23 A5 P23
24 A4 V21
25 A3 U22
26 A2 V20
31 Al W24
32 CE# AD24
34 OE# AC23
85 DQO AB23
37 DQ1 AB24
39 DQ2 AA23
41 DQ3 AA24
44 DQ4 Y21
46 DQ5 Y22
48 DQ6 Y24
50 DQ7 Y23
ol DQ15/A-0 W21
53 BYTE# W23
54 Al17 V22

44 SDRAM
SDRAM K F #2255 E BLAC A 1 1 HY57V561620, &8k 32M F75. % 4 451 T SDRAM [() 45
[T B o
% 4 SDRAM & Hstst

| SDRAM HY57V561620 |
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2 DQO L3
4 DQ1 K3
5 DQ2 E7
7 DQ3 F3
8 DQ4 G3
10 DQ5 F6
11 DQ6 F1
13 DQ7 H3
15 LDQM G5
16 WE_N J4
17 CAS_N K5
18 RAS N L6
19 CS_N L7
20 BAO M4
21 BA1 L9
22 A10/AP L10
23 AO N9
24 Al P9
25 A2 M3
26 A3 M2
29 A4 B3
30 A5 C3
31 A6 B2
32 A7 C2
B8 A8 D2
34 A9 D1
35 A1l E2
36 A12 El
37 CKE F2
38 CLK E5
39 UDQM G2
42 DQ8 Gl
44 DQ9 H2
45 DQ10 H1
47 DQ11 J2
48 DQ12 J1
50 DQ13 K2
51 DQ14 K1
53 DQ15 L2
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o X1 Xd

14 ®BROEQO

x5 SmOEHMRE
UART MAX3232C
MAX3232C %' (TOP) | MAX3232C %144 | FPGA & 4w 5
11 UART TXD T21
12 UART RXD 720

46 PIRMO

PLA 0 R T2 Davicom 23w ) DMO000A, %0 & 10/100 [H3&E N LU MM A, s T
MAC #l PHY JZI e, &0 BEAE AR BEES 2 , BA MIL Y PHY 2800, ARZGR#EH
FPGA B 2 I ALFE B2 11, 26 6 45 H T LUK IS0 45 AT 5

6 LIKME HERIRSS

Ethernet DM9000A
ETHERNET & 4w "5 | ETHERNET 4142 | FPGA & 4w 5
10 SD7 B4
11 SD6 C4
12 SD5 A4
13 SD4 A5
14 SD3 B5
16 SD2 A6
17 SD1 C6
18 SDO B6
22 SD15 A7
24 SD14 B7
25 SD13 C7
26 SD12 A8
27 SD11 8
28 SD10 BS
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29 SD9 A9
31 SD8 B9
32 CMD €9
34 INT A10
5 IOR# B10
36 IOw# B11
37 CS# C10
40 PWRES# B12
44 X1 (25MHZ) F12

47 70%6 EEERESR

KO R A 6 AN 70 &8 B i 6 8% (J1~05. J7), W 3CHE 100MHz [ mdifE S, & i
WS EMME, RS HH B 15 B, 76 F R b R HE e ek, @ 2
BT, AL HT .

15 HEEERIHEF
B 16 45 i T A% O A A RE A (AT ) o
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E 16 fHEEFAER O ERIGIE
48 LED{T

o 4 8 4~ LED 4] (LED7~LEDO0), AN FPGA &Mk, LED 4Tk (B 17). £ 7
45T LED FRAS TR

LEDO LEDL LEDZ LE
; LED ; LED ; LED ; LE
17 LED fTi%#E
# 7 LED ZHaRst
LED
LED 45 | LED % 4w = FPGA 4 i 4 5
LEDO 2 G6
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LED1 2 G4
LED2 2 K6
LED3 2 H6
LED4 2 J3
LED5 2 J6
LED6 2 J7
LED7 2 K8

49 &4

K B =AM RESET. KEYO fil KEY1, AN #GESEE 1/0 &, BEA] LAY VR0
/0 F, trfLIEN RESET i . #4041 4% F 2Rl A, G 2w T (KB 18). £ 8 4 Ti%
LI BT E)

VCC3 3

10K

RAD_O

18 1z{HEEE
=8 IRIHERIBREY

KEY
Yggn s | KEY & 405 FPGA & 4 =
KEYO 1,2 F4
KEY1 1 L4
KEY2 1 J5
KEY3 1 K4
RESET 3 C5

5 #RWIMZ

51 A/D

AID K AD A1) 9203, £i7 %5k 10 Fokr, w2k 4A0MHz (FSRFER . 5 AR H ST
AR T 28 AR A 0 7 ik 2 AD9203 1) fir N i o S AAR JK 2% ADT1-1WT ) 3dB 77 % &
0.4~800MHz. AD9203 H#iiRFfa 551k 130MHz. i+ FAAMEkZ (S1) mTLliEESF MR,
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R S1 R AGND JEAE—i2, MZH i S 1V; 1R S1 R VREF 4 —if, 2
ZEH & 0.5V,

%9 FPGA #1AD Hj#E0

AD9203

3 DO PIN E26 J12 43 J5 44
4 D1 PIN E25 J12 44 J5 43
5 D2 PIN F26 J12 45 J5 46
6 D3 PIN F25 J12 46 J5 45
7 D4 PIN 625 J12 48 J5 47
15 CLK PIN D26 J12 41 J5 42
8 D5 PIN P17 J13 47 J3 48

D6 PIN N24 J13 48 J3 47
10 D7 PIN R17 J13 49 J3 50
11 DS PIN T17 J13 50 J3 49
12 D9 PIN R19 J13 51 J3 52

5.2 DIA
D/IA R JE TI A A DAC904, #54uidi Rk 165M R 5/#r, 7%k 14 Hfs.
% 10 FPGA #1 DA gh#0

DAC904
14 DO PIN M19 70 69
113 D1 PIN P18 69 70
12 D2 PIN_L19 68 67
11 D3 PIN_M20 67 68
10 D4 PIN_V24 66 65
9 D5 PIN_V23 65 66
8 D6 PIN_U23 64 63
7 D7 PIN_T18 63 64
6 D8 PIN_U21 61 62
5 D9 PIN_T19 60 59
4 D10 PIN T24 99 60
3 D11 PIN T23 58 o7
2 D12 PIN R20 o7 58
1 D13 PIN_T22 56 55
28 CLK PIN_U20 53 54
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5.3  4*4 e

A5G R B B A 7]

PR A 4%4 AR (S3~S16) (K] 19), 34 8 5| FPGA 1 10 3% (£ 11).

Lo e

g|u[0]s

a [0]

O

=

O

=

i#“

E 19 4*4 FAiieEr=EE
F= 11 AEESE RS

KEY
S3 2 PIN W15 61 62
4 PIN V10 70 69
54 2 PIN Y14 63 64
4 PIN_V10 70 69
S5 2 PIN_AA14 64 63
4 PIN_V10 70 69
S6 2 PIN_W10 67 68
4 PIN_V10 70 69
ST 2 PIN W15 61 62
4 PIN V9 69 70
S8 2 PIN Y14 63 64
4 PIN_V9 69 70
59 2 PIN_AA14 64 63
4 PIN_V9 69 70
S10 2 PIN_W10 67 68
4 PIN_V9 69 70
S11 2 PIN_W15 61 62
4 PIN V11 68 67
S12 2 PIN Y14 63 64
4 PIN V11 68 67
S13 2 PIN AA14 64 63
4 PIN V11 68 67
S14 2 PIN W10 67 68
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4 PIN V11 68 67
S15 2 PIN_W15 61 62
4 PIN_Y15 59 60
516 2 PIN Y14 63 64
4 PIN Y15 59 60
S17 2 PIN_AA14 64 63
4 PIN Y15 59 60
S18 2 PIN W10 67 68
4 PIN Y15 59 60

FREEAE ) TAERIEN T (A2F CGERIERT) HsER):
KRO-KR3 AT 2k N i, HIUG4k K~ fr BRI E A 1
KCO0-KC3 My#l kit v, HIdAE Ak s .

R 12 175w RIAR 5T

KCO PIN W10
KC1 PIN AAl4
KC2 PIN Y14
KC3 PIN W15
KRO PIN V9

KR1 PIN V10
KR2 PIN V11
KR3 PIN Y15

BRI Ee ki KCO-KC3 [a Ty A i b s, #1748 KRO-KR3 (1)
W& BATERSE MR, WRITEE T, Ha R, WEERWAEER T SAEIET, %
HEATIEL, WEEOR, FxaE— T3, B KCO-KC3 P4 A4944 20 Wl i Wi, AERER
P, RS T 2k KRO-KR3 (PR ZS, #fised (. filtn: KCO-KC3 it “01007”, MLty
L KRO-KR3 [RPIRASh “10007, W HIF45E S5 #ri% T,

TEFLBE PG AIST TF IR (R 25 7= AR VP 2 Ak, RFEEIN R 20 LR B L2280 o 2 ) 380 4 S
N Ja, EIFUE A, T LRERE M 2R — O, ERDESE N U BE e A AH R, DA
HRE LM R WEHETEY MmsX N, #1 M B 10 =58, N HL 5.

54 IR

PR 10 MRS R (B 200, [ B AH N B e e, 1) PR B BRI AR - (B 210
R 13 N IRENIT I I o

20 RENFFREZE

22



A5 2 PARTT 1 6 WS

swi
EOA(IS

B 21 KEsHHhFETER (BERTFRMNE)
F 13 IKEhIF R E R ET

BTG K RHE A A A

swi
e

SW
SW SW Pin | FPGA J16 Pin (¥ EHO J7 Pin (00
SW1 2 PIN AB15 60 59
SW2 2 PIN AA15 57 58
SW3 2 PIN W16 58 57
SW4 2 PIN AAL6 55 56
SW5 2 PIN AD15 49 50
SWe 2 PIN Y16 56 55
SW7 2 PIN U17 53 54
SW8 2 PIN V17 54 53
SW9 2 PIN W17 51 52
SW10 2 PIN Y18 50 49
55 LED4T
P A 16 4~ LED 4] (D21~D36), MKH AR (K 22), & 14 45H T LED % L o
0
= _ R38 < | - a _ Re2 < | Lot
- _ R59 < | - = _ RE3 < | -
D’Im N ,.l'\?‘ECf\ < | LED2 EH:T ra ,l'\?&.-'\ < | LEDE
h 330 e 330
La¢ 1 028 RES
P AN L P AAA——
L3 FEE D33 =70
H\\ )'\f\;"\ < |].EI2€ ”\\ )'\,l'\f\ < |LEI312
E’ISC N ﬂ?ETA < | LED9 EN:R N ,l'\?\?l.-"\ < | LED13
” = M ,z'\-t Fay < | LED10 N = Y {'\m_/\ < | LED14
o -
_H_/\M_ ¢ e _N_/\M_ ¢ LEDts
h 330 e 330

22 LED ¥Ti&E#E
% 14 LED &Rk gt

LED

23
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LEDO PIN V18 47

LED1 PIN U18 48 48
LEDZ | PIN_AE15 44 47
LED3 | PIN_AE16 41 43
LED4 | PIN_AF17 40 42
LED5 | PIN_AE18 37 39
LED6 | PIN_AE19 35 38
LED7 | PIN_AF19 36 36
LED8 | PIN_AF20 34 39
LED9 | PIN_AE21 31 55
LED10 | PIN_AF21 29 32
LED11 | PIN_AEZ23 28 30
LED12 | PIN_AA13 26 27
LED13 | PIN_AF23 25 26
LED14 | PIN Y13 23 26
LED15 | PIN_AC16 20 24

56 ¥ RERED

PRER AP 40 BRI BRI (J17 R0 J18), LA RHE LB

23 ¥RIZEOEMHES

Ji7

24



Hr 5 2 AT R

B=RUED

J17

J18

[T
WEOLLLGHH

24 YREOETRIREMMGE

* 15 J17 EHERE

1 | PIN R5 2 | PIN_J10
3 | PIN T8 4 | PIN U
5 | PIN_T10 6 | PIN U9
7 | PIN P4 8 | PIN R3
9 | PIN U4 10 | PIN T4
11 | vcesv

13 | PIN V5 14 | PIN V7
15 | PIN V3 16 | PIN W3
17 | PIN Y5 18 | PIN AA5
19 | PIN AD3 20 | PIN AB4
21 | PIN AA6 22 | PIN T2
23 | PIN V2 24 | PIN U2
25 | PIN AD4 26 | PIN W2
27 | PIN_AC5 28 | PIN AE4
29 | VCC3. 3V

31 | PIN AAl 32 | PIN_AC6
33 | PIN ABI 34 | PIN AD5
35 | PIN AE5 36 | PIN AP4
37 | PIN AD6 38 | PIN AF5
39 | PIN AF6 40 | PIN AE6

25
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ECISEZ LSV e B RE

* 16 J18 EHEE

1| PIN J14 2 | PIN_J13
3 | PIN_T9 4 | PIN R6
5 | PIN 17 6 | PIN U5
7 | PIN V6 8 | PIN U7
9 | PIN U10 10 | PIN P3
13 | PIN T6 14 | PIN R4
15 | PIN T3 16 | PIN U3
17 | PIN V3 18 | PIN V4
19 | PIN W4 20 | PIN W6
21 | PIN AA3 22 | PIN Y4
23 | PIN AA4 24 | PIN AB3
25 | PIN AE3 26 | PIN AC3
27 | PIN_AA7 28 | PIN R2
31 | PIN V1 32 | PIN U1
33 | PIN W1 34 | PIN Y1
35 | PIN_AB2 36 | PIN_AA2
37 | PIN AC2 38 | PIN AC1
39 | PIN_AD2 40 | PIN AE2

5.7 128*64 ¥

WA T2 DK B IR NTT532, 38 17 25t T Wl o 1 T L

=17

B

AT A T

LCD LCM12864H

1 s PIN_AC19 10 9

2 RST PIN AC20 9 10

3 D/C PIN_AB20 8

4 SCK PIN_AC21 7

5 SDA PIN_AD21 6 5
58 USB#H

USB 5 R JH 952 Philips 1 OTG &5} ISP1362, Mils B AT LL2Y Slave [, 7] LAY Master
. 18 45 T ISP A% w5

%18

26
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A5 Z AT R 5 W45

A5G R B B A 7]

0TG ISP1362

61 A0 PIN D6 J10 33 J2 34
62 Al PIN HS J10 36 J2 35
63 DO PIN J8 J10 35 J2 36
64 D1 PIN F10 J10 38 J2 37
2 D2 PIN 69 J10 37 J2 38
3 D3 PIN G10 J10_40 J2 39
5 D4 PIN K9 J10 39 J2 40
6 D5 PIN F11 J10 41 J2 42
7 D6 PIN G11 J10 44 J2 43
8 D7 PIN J9 J10 43 J2 44
10 D8 PIN G12 J10 46 J2 45
11 D9 PIN H10 J10 45 J2 46
12 D10 PIN H12 J10 48 J2 47
13 D11 PIN H11 J10 47 J2 48
15 D12 PIN F9 J10 50 J2 49
16 D13 PIN M5 J10 49 J2 50
17 D14 PIN E8 J10 51 J2 52
18 D15 PIN E10 J10 54 J2 53
20 RD# PIN E12 J10 53 J2 54
21 CcSt PIN C11 J10 64 J2 63
22 WR PIN D7 J10 56 J2 55
24 DREQ1 PIN D5 J10 55 J2 56
25 DREQ2 PIN D9 J10 58 J2 57
28 DACK1# | PIN D8 J10 57 J2 58
29 DACK2# | PIN D11 J10 60 J2. 59
30 INT1 PIN D10 J10 59 J2 60
31 INT2 PIN D12 J10 61 J2 62
32 RESET# | PIN C12 J10 66 J2 65
49 OTG DMl | PIN K7 J10 34 J2 33
50 OTG DP1 | PIN H4 J10 31 J2 32

59 HHO

JEEARH) J9 & —A> 9 1) RS232 #: 111, D2 I D3 73l R IX MM /R 4T« R 19 45 T H 1

RV DR 55 o

* 19 FROERME

MAX3232C

11

UART_TXD

PIN_K17

J8_63

J4 64

27



ot 5 S AR T R4 Ui 45 B AR R AT R A

| 12 | uaRT RXD | PIN I8 18 64 J4 63

5.10 VGA #iiED

VGA % i3 1705 R B AD 2 5] 1) ADV7123 >k RGB #4155 1) DA 48k, £ 20 451 T VGA
2 115 i B

# 20 VGA ZHnhgt
VGA ADV7123

39 RO PIN B20 J8 28 J4 27
40 R1 PIN A20 J8 27 J4 28
41 R2 PIN B21 J8 30 J4 29
42 R3 PIN A21 J8 29 J4 30
43 R4 PIN A22 J8 31 J4 32
44 R5 PIN A23 J8 34 J4 33
45 R6 PIN B22 J8 33 J4 34
46 R7 PIN D14 J8 36 J4 35
47 RS PIN B23 J8 35 J4 36
48 R9 PIN E15 J8 38 J4 37
1 GO PIN F14 J8 37 J4 38
2 Gl PIN C15 J8 40 J4 39
3 G2 PIN D15 J8 39 J4 40
4 63 PIN F15 J8 41 J4 42
5 G4 PIN C16 J8 44 J4 43
6 G5 PIN F16 J8 43 J4 44
7 G6 PIN C17 J8 46 J4 45
8 7 PIN D16 J8 45 J4 46
9 68 PIN D18 J8 48 J4 47
10 69 PIN D17 J8 47 J4 48
14 BO PIN D19 J8 51 J4 52
15 B1 PIN D20 J8 54 J4 53
16 B2 PIN F18 J8 53 J4 54
17 B3 PIN C21 J8 56 J4 55
18 B4 PIN G18 J8 55 J4 56
19 B5 PIN (22 J8 58 J4 57
20 B6 PIN E20 J8 57 J4 58
21 B7 PIN J17 J8 60 J4 59
7 BS PIN D21 J8 59 J4 60
23 B9 PIN €23 J8 61 J4 62
11 BLANK# | PIN C19 J8 50 J4 49
12 SYNC# | PIN E18 J8 49 J4 50
24 CIK PIN F20 J12 1 J5 2

28



§

A5 Z AT R 5 W45 A5G R B B A 7]

511 AV &IAIEDO

AV SINK T RCA #:100, 005 R /2 AD A ADV7181, SERE AT 5 1) AD 254k
X 21 45H T ADV A IS .

£ 21 AV ERInhsT

ADV7181B

51 RESET# | PIN F21 J12 2 J5 1
54 SCLK PIN E22 J12 4 J5 3
53 SDATA | PIN C24 J12 3 J5 4
8 P8 PIN H24 J12 15 J5 16

P9 PIN G24 J12 14 J5 13
6 P10 PIN G22 J12 13 J5 14

P11 PIN G23 J12 11 J5 12
62 P12 PIN G21 J12 8 J5 17
61 P13 PIN E24 J12.7 J5 8
60 P14 PIN E23 J12 6 J5 5
59 P15 PIN D23 J12.5 J5 6
2 HS PIN F23 J12 10 J5 9
64 Vs PIN F24 J12.9 J5 10
20 LLC PIN P25 J13 54 J3 53

5.12 ¥

PRERRAT 8 AN FLFH\ B, 3 RS ) ) 05 30 EOCRE 110 #2105k
M T HAfrER T (K 25). ARG & ket o2 BAE NIRAOPLEE A3 IH 2 A7 —
Bt ia), PRt — A e R N BLE IR BT,  HILE SR L mn, XAMFmmEtiis—H
BAE NI AL b, UAE IR SROX A Y IE BAF AR o X TR o s, WORAEE AR RGN
] T NI, TARRR N IUN TR ¢ GRS t<T), W2 T 2%/~ (Flin T=10ms i), FATHEZXAD
BIRAAG O IESE B T o WIRE RN s 8 AN, WIFRATA LU AHEREA Y T )
Ji% 8 Bt R ds A A R — BON R AT o (B t=T/8).

WRBS A ) TLx(x=0~7)sm i Jic, —AA 8, 1. 6 JLPHPIAME &, X A i) s A
P wos ok PTELAA R ik, JE AN W P ] TL Sk 2 i Bt 2 75 o

29



A5 Z AT R 5 W45

25 HARLE EKE
R 22 NG 23 73 4 T KR R i BB 55

R 22 HALEERIBRET

A5G R B B A 7]

CLEEERED

KR T L

10 A PIN AD16 J16 19 J7 20
9 B PIN AC17 J16 17 J7 18
8 C PIN ABIS J16 15 J7 16
5 D PIN AD19 J16 11 J7 12
4 E PIN AC18 J16 14 J7.13
2 F PIN AA17 J16 18 J7 17
3 © PIN AD17 J16 16 J7.15
7 DP | PIN AAIS J16 13 J7 14

F# 23 HEE=WREEMRE

B — W A S
L7 TLO | PIN W19 J16 45 J7 46
L8 TL1 | PIN AE17 J16 39 J7 40
L9 TL2 | PIN AF18 J16 38 J7 37
L10 TL3 | PIN AE20 J16 33 J7 34
L11 TL4 | PIN _AE22 J16_30 J7.29
L12 TL5 | PIN AF22 J16 27 J7 28

30



ot 5 S AR T R4 Ui 45 B AR R AT R A
L13 TL6 | PIN AC14 J16 24 J7.23
L14 TL7 PIN AC15 J16 21 J7 22
5.13 HEHiEO
TR L0 R B2 R 2\ ) UDAL341TS.
J5: Audio Line out.
J4:Audio Line In.
J3:Audio Mic In.
Audio UDA1341TS
17 WORDSEL PIN F13 J8 2 J4 1
16 BITCLK PIN G13 J8 1 J4 2
15 L3 DATA PIN G15 J8 4 J4 3
12 SYSCLK PIN G14 J8 3 J4 4
18 DATAOUT PIN R7 J14 68 J1 67
19 DATAIN PIN P6 J14 67 J1 68
13 L3 MODE PIN R8 J14 70 J1 69
14 L3 CLK PIN P7 J14 69 J1.70

6 & F EDA HR&EH

6.1 %A T A Quartus Il FfFEH

Quartus 11 /& Altera 24 &0 FPGA #EH A T M85 . 7EiX BLd i —M44 5 LED 1 1%

6.1.1 TIEEEL

1> FTJF Quartus Il (RWindows [#7F451 -> [#2)¥]1 - [Altera] -> [Quartus 1 7.0] -> [Quartus II
7.0 (32-bit) D, rfiddi [File] -> [New Project Wizard) 33, 42BN 26 FrosiiiHE, 2
—ATH TR TREKA, BT TEA, S TReka 234, E8R
A TR TEAL—, AT A OB, XRA#—/N 40 LED [ TR

=P

KA ZEHA 21 Quartus 1 GBI RE, % TR RENS SEBURZ AR L1 LED ST AWK Rl N . ASCR

HI¥52 Quartus 117.0 fitAs,  HARRCA A iR AU

31



Bep SEBHETFR TSR TS R A A

Quartus II

File Edit View Projeet Assigoments FProcessing Tools Window Help (]

[osa|e/smalo | X s@@e|Tirv w0 % 0% 4 e

Project Mavigator — . =

Entity iLoglc Cells
Compilation Hierarchy

;Nev Froject Wizard: Directory, Name, Top Level Entity [Dage--

“What iz the working directory for this project?

[dhalleratTOVLED =

‘what iz the name of this project’?

led _I

‘what is the name of the top-level design entity for this project? This name is case sensitive and must
exactly match the entity name in the dezign file

led _|

Use Existing Project Settings ...

B S II

-Hierarchyl Filesl #? Design Unitsl Version 7
Status
=
Wodule [Prog... Z[Timed |

& Documenta

2 < Back I Hext > I Finish I BiH |

26 IiEENHRm

2) gl [Next), HIRASINSCAEXSIEHE, Wl 27 Fros. F P nl LOKE Cgm i b i s 1 SR in 2]
TREH . FEARBIHAGINEM SCfE, H# A S [Next].

File Ed&it View FProject Mssigrments FProcessing Toeols Window Help

[EECTEIEET I ET e— L ST

Froject Navigator

Entity 1
dy Conpilation Hierarchy| [Hew Project Wizard: Add Files [page 2 of 9l
Select the desian fles you wan to includs in the project Cick Add Allto add all desian fies in the
proiect ditectory to the pioject. Note: you can always add desian fllss to the project et
Eile name: || Add
File name [ Tupe I Add Al
Bemove
Propeities
Up
: - Down
Iy Hierarchy | B Files | ¥ Design Units
Status
Module |Proz... Z[Time & |
@ Documentat
Specily the path names of any non-defaul libiaries. User Libraries...

<Back | Wext > | Finish | HiE |

E 27 HiRmmSRE

3) 4 [Next]->[Family & device setting] % 1, XS uRAEH SRk $E H b as2F, BIFTEH 11 FPGA
R o IXANIEIN S B 5 255 R 8O0 sof ARG, iX HLik ¢ EP2C35F672C8.

32



ECISEZ LSV e B RE A5G R B B A 7]

Entity | } |

ConpiLation M erarchy| Hew Project ¥izard: Family & Device Settings [page 3 of 61
Select the family and device you want to target for compilation
[~ Show in "Avallable device' list———
Eamiy  [Cyclane 1 =] Packans e =l
i~ Target devi m
 Auto devics selected by the Fitter i count T
& Specific device selected in ‘Available devices' list Speed grade:  |Any =
Core voltage:  1.2%
¥ Show advanced devices |
[T HardCopy compatible only L
Available devices: _—
&y Hisrarchy Filasi &F Design Units Mame | LEs | Memor... | Embed... | PLL | -
EPZC35FE720E 33716 483840 70 4 Version 7.0
Status EP2C35FE72C7 33216 483840 70 4
Module |Prog... Z[Time & | EP2C3RFEFCE 33716 433040 70 1 =
EP2C35FEF2IE 33216 483840 70 4
EPZCS0FE72CE 50528 594432 172 4 L
EPZCS0FE72C7 50528 5944732 172 4
EP2CEOFEF2CE 50528 f94432 172 4
EP2CE0FEF2IE 50528 f34432 172 4
FPOCPNFR7ICR FR4IR T1RINON A0 4 L) @ Documentati¢
= E|
p I =
< Back et > Finish | Bl |

28 JHKEFRE

4> miili [Next), HEANZE =5 TRIEREE L, Mol AR B AL A = () EDA TR, il
Synopsys, MentorGraphic 45, fEAGIH AL =77 TH. 4kt [Next], #fA LED
Summary & 1, & H45H T LED WUH M5 B 2. iy [Finish), SEp TREEEAL,

AR PR P RN BRI E e ST e [Assignments] %51 1) [Settings] i%

T B 5L

6.1.2 Eirigit

Quartus Il SZFFZFHETH4m AN J7 38, FILALE Quartus I Block Editor # 7 JR FEP vl mlAd
Quartus Il Text Editor #%#%% AHDL. Verilog HDL 5§ VHDL Cf:3k#47¥1t: Quartus Il B fFi4 7 4%
K EDA Bl s NFIZits T RA ) EDIF AN SCfF(edf) 80 VOM SCfF (vgm) SkREESZ I, X
R ZEAZELE Quartus 1 WA BEAT AR5 5 v AN U B R

1) ®WHESH

Quartus I SCRFAERE 5 H AHDL. Verilog HDL #( VHDL, XHEHi#—44 led_core
(1) Verilog HDL (.

a) {EF% N FE#E [File]l -> [New] , ## Verilog HDL File 3 fithi [OK] mhn] LLih
I SCAS G B ATE

b) X TH%# Quartus IT $&4E TR 2 WA, 76 4B AE b i A Bk £ [Insert
Template] , XFiEHEZC 3 R K] Quartus TT 2B A, X HLiE$¢ Verilog HDL,
PEAT 3% $E Module Declaration, U1 29 Fir. XM 4miHE + 2 H B Verilog HDL £
B 7 B AR o

33
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3bE Fils Edit 3 Froj Help
D@ H|& + faos Hds@@e Tlr o n @B ae
Project Navigator “2 B Vedlogl v ]
Entity | Logic
Cyelone TT: EPZC3SFATZCH =l
..... B add (Y M ‘Insert Template
Show syt o Template section |
8 AHDL Generate If Statement |
Quartus 11 Tel If Statement = Cancel
5= Tcl Integer Declaration
Logic Function [and)
i= WHDL Logic Function [buf)
= Logic Function [nand)
% Lagic Function [ner)
Lagic Function [not)
% Logic Function [or)
= Lagic Function [sner)
Logic Function [xor] 3
£ 2] I o
EyHierarchy Files | g Design Units L= Mudule Instartistion
Parameter Declaration
i — U Porl Declaration
= o Supplyl) Declaration
Module [Prog . #[Tine & | 2 Supplyl Declaration
= Task Statement £
Freview:
|28t
28¢ wodule module name [~
lab’ i [l
am input input_namel,
BEAN input input_name?,
% outpur oucput_namel, =
outpur output_name?,
inout inout_namel,
inout inout_nameZ
1 o
#/ Module contents F
[

29 Verilog HDL f&E#Ri7RA0

o) AECAHEP A Verilog HDL AXHE (K 300 , JF0RAFEN led_core.v 3.

=
3tz led_core.v 1 @ Campilation Report ]
module led core(clk, reset, LED):

@ input clk,reset;
# output [7:0] LED:

reg [3:0] state;
C'\.: reg [24:0]counter;
—F reg [7:0] LED;
8]
i= always @ iposedge clk)
©= if [ !reset)
= counter <= 25'h0;

else
A
counter <= counter + 1;
always Biposedge clk) begin
if [ !reset)
= state <= 4'hH1000;
R else
if jcounter == Z4'b0)
T if (state <= 4'h0111 £& state >=4'bO0O00O)
state <= state - 1;

(3
a else
267 state <= 4'h0111;
265

end

& 30

Verilog HDL {CAZHI N\ R

d) 7t Quartus Il A LURLEPRE 5 Bt e 4 o S BE B Vot A 5 B1os, il 31 s, miad
[File] -> [ Create/Update] -> [ Create Symbol Files For Current File], # F—2 1
led_core.v SCAF I 544 Smbol SCA:.
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8 File Edit View Project hssignments Processing Tools Hindow Help

[0t a5 [ sV T|(r D

[ Open Cirltn

—| Close Cerl4Fd ¥ 1 @ Compilation Feport
£ c
= wodule led corelclk, reset, LED):
é@ﬂew Project fizard .. input clk,reset:

[E5 Open Project.. Curlt] ocutput [7:0] LED:

reg [3:0] state:
reg [Z4:0]counter:
reg [7:0] LED:

Convert MAX4PLUS II Project...

Save Project

Close Fraject

always Bi(posedge clk)
if [ lreset)

counter <= z25'h0:
Save As. ..
else

counter <= counter + 1;

File Properties

always Biposedge clk) begin
< - .
d
a5 ol Files for Current Fils
St Convert Programming Files. Include Files for Current File
We ate »>=4'LO000)
C 0 Fage Setup
[& Print Preview
& Frint. CLrltF
< Fecent Files »
x Recent Brojects 3
CreatefUpdate IFS File
Exit ALtHF4
s o e £f LED -c LED --gene

31 Verilog HDL 34351k % Symbol 32
2) BFEEER
Quartus Il Block Editor JJ LA Jst 7 TR B AR 3 AN A G iR Be it o B U8R I e ot 3
PR FNFT S (Symbol) , IXEECHFIFF 5 AR 1)@ %, Block Editor KMkl SR B
KIS S AR B A A B TR . X BEAE ] 2D AR B 5 o B B P 7T
a) Hrid—> Block Diagram/Schematic File.F: 4w HAE 7 X it7 Sl bR 2o 8, 25 HILAT S0 URHE, 40
Kl 32 fizn. #2232 Project SO R 4x £ led_core, 764734 %o led core AT S, sl

[OKY J&, AILLKEF S ¥ sl eit .

Symbol I
Libraties L lLliliiiiiiiiiiiiiiiiiiiiiiiin

5 & Project L :

£ d:falera/ 70 quartusibraries?

.............. LEO[..0]

BRI X |

[ Bepeat-insert mode
[ Insert symbol as black,

e
- )
Megawizard Plug-In Manager... |
)
q Ok LCancel |
[

32 FFSIIEERE

b) B ORI B IS A 1, FEAT 5 X AE P K Name FHHTA input TXIN 2 HY B A o
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HIRF 5 o RFIEAT SN 21 J5 BE B i A T JF 55 Led _core AR ASR clk AHIE, Wil 33 Pras.

clk LED[F..00
reset

inst

33 A E IR0
¥ LR EIFF S ZHIIE L reset di UAIE 4% 1855 input #1117 197 276 Symbol $HEHE - £ 1 output
It ¥t 1 LED A,
c) A AN A2 F TS, REEAF S AR UE Pin name TR I 44 . TR TR

F G VA% LED[7..0], AN J2 LED[7:0].

Pin Fropertie= ]

General lFormat I

To create multiple ping, enter a name in AHDL bus notation [for example,
“niame3..0]"], or enter a comma-separated list of names,

Pinnamefs)  |=E

Default value: |\.f[;c ﬂ

: Wz i

34 AL EREERE
d) Fut, BEAEEEBE, WK 35 Pn, KRz A N TR R S0 EAL led. EICH
A BRI TRERE LI E SRR S 44 A 1] o
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olk | — olke LED[F..0] T N =T
reset :_%g reset | E e
A 117 D

& 35 LED [RIEE&t

6.1.3 SMHTSRE

HE$E Quartus Il =% H1¥) [Processing] -> [Starting), # A% % Quartus 11 SR 0 BT 454 L
H, orbrdcts, LG, AL, NP0, Wikl 36 Prs. sidi Start Analysis & Synthesis
AT S LR

Processing Iools Hindew Help

LR R R AR S R DR
P Start Compilation CtrltL

£
3 [

3 P\/ Start Analy=iz & Elaboration

Update Memory Initialization File ’\7 Start Analysis & Synthesis Ctrl+E
@ Compilation Report Ctrl+R EE Start Partition Merge
B0 Start Fitter

Start Compilation & SimulationCtrl+Sha ft+E e
ﬂ“ Start hssembler

Generate Functional Simulation Fetlist

. . P4 Start Classic Timing Analyzer Ctrl+Shi £4+L
5’1 Start Sipulation Ctrl+I -,
. . 74 Start TimeBuest Timing Analyzer Ctrl+Shi £14T
Simulation Debug 3 .
&, Start EDA Hetlist Writer
¢ Simulation Keport Ctrl+Shi £E4R

ag Start Design Assistant
Compiler Tool w Start PowerFlay Fower Analyzer Ctrl+Shi f++F
@ Simulater Tool
EJ Claz=ic Timing #nalyzer Tool
3 f}f PowerPlay Power Analwyzer Tool
[l

4 Start SignalProbe Compilation Ctrl+5hi £145
'_/ Start I/0 Aszignment fAnalysis

Start Claszic Timing dnalyzer (Fast Timing Model)

& 36 Quartus Il HHfrEEE THEF
FEGRTERT, W LAAE Settings 2870 1 50 B — LU S B {40 4 P64 R I — SR Jall B £ 45 R I HE AR
o LRRGm PRI, A B R R R . XL, AT R B TR AT SR G
6.1.4 EHISE
EH [Assignments] -> [Pins), HEATIXA TREME A EC, a0l 37 fzr, 7E Location £ HLIH
5 5 N O R Pin Ji
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SH KB RHEA R A E

B Pin Planner | & tedcorev | & Complation Rleport - Plow Summeny
= m - = Brattorn View - Wire Bond
T = Cytlone Il - EF2CI5FETICE
b & Hods Name.
OE||®E kdr.0 e
o o 7] [Cutes,
o ledl£] ==
=] | | (5] B
= = |2 4] Outps,
— o 3] ==
== o (2] B
| e e 1] [z,
o le0) [ndpr,
o & <anew rode s>
5 |
&8
&
h@
%
< >
" Hawed [f =] Edt ) | NS Faee [P ot =)
Hade Name | Dirgction | Location | 1 Bark. [ mefGmp | T Rezarved || G
1 [ Tt FIN_NY 7 = {336 LVTTL (def it} |
2 o kd7] loutp FIN_YD Iz e |30 LHTIL (defonik) Jlcf7_ 0]
E] @ leds] Curprt PIN_TT 2 B2 N0 |33V LVTTL idefank) ect7..0]
4 o leds] Cutput FIN_ % 2 2 _NO 13,39 LVTTL (cdef i) Jucf(7.0)
5 o leds] Outpt N3 Iz | 1336 LWTTL (defouik) Jiec7_0)
i & ed3] Cukpnk JFIN_HE 2 B2 O (33K LVTTL (defondt) Jloc7. 0]
7 @ kd2] Outon FIN Kb 2 02 o .00 LVTIL (defenk) Jlad(7..0]
] o edl] fouepr FIN_GH Iz [52 o [3.3¥ LNTTL (def o) Jeet7..0]
B £ 0 Cntiu #IN_GA 2 620 13,3 LYTIL (il ) Jet7. 0
g [0 | et Jingus: FINCS Ia Jea_ny 1.3 LWTTL (defonik) r
&
5 /e »

(1 N W TRER U,
BT .

&

37 Quartus Il EfISECFE

HB ORAFAE TR PTAE ST IR .qsf SCPEAp S BRATTRT L G0 R AN SRk

HEREXFAME I, 16 settings X HHAEH %) Unused Pins 1328 4 input tri-stated, 1% 38 Jir

X

| Settings — add :

Category

General
Files
User Libraries [Current Praoject]
Device
[#- Dperating Conditions
[#- Compilation Process Settings
[# EDA Tool Settings
[#- Analpsis & Spnthesis Settings
[#- Fitter Settings
[#- Timing Analysis Settings
Assembler
Design Azsistant
SignalT ap || Logic Analyzer
Lagic Analyzer Interface
[#- Simulator Settings
PowerPlay Power Analyzer Setti

s

VA

Iy BE 78 1

[‘Device & Pin Options

Seleot the family and device you want to target for compilation

Family: |Cyc\une I | Show in ‘Available devices list—

. - Package: Any -
oG 1
Pir count: E72 ¥
— Target devics
| | Sneed rade | -

Dual-Purpoze Fins | Voltage ] Fin Placement | fevices
Error Detsction CRC | Capacitive Loading | Board Trace Modsl | .
Gemeral | Configwatien | FProgramning Files

~

Specify device-wide options for rezerving all unused ping on the device. To reserve

individual dual-ourose confiouration oins. oo to the Dual-Punose Pins tab. To
reserve other pins individually, use the Assighment E ditor

Reserve all unused ping: | SR S ARt =]

[ 38 Unused Pins i& & - m

FEFF T3] H AR EIFREAT B

6.1.5 EBFETH

» JTURGRE, PR A TRER A B A i 5e i, 5 T oMokt

GiELE RS, Quartus Il 2B RS NERET, X T.sof Fil.pof 3. Hidr.sof HT JTAG

BN, XAy SRR 4 N33 FPGA Y, Wi SRy £ 5% Tiii.pof WIHTT AS BT
#(Active Serial), XFh T R HA%E N3] EPCS fEigdsd, Wil SfEmASER, SRnd)E
EPCS H L4 A 8hn#k 3] FPGA . HAK N 57k T

D ATITHIE, K PC 5 HART T #4847 . il Quartus IT H' ) Programmer & |
LEERINE L N2 B, sof 2. sihi Hardware Setup ##, Quartus II H %482 USB-Blaster,
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IR RN, "] RE e AR FE Y - 7E# R 3 USB-Blaster )&, 7F Hardware Setup
ik I USB-Blaster. { Program/Configure J7HEH T2, FHEMILESE JTAG. K H stk b
()R B USSPk 7E RUNCIRA, 285 il Start JFUR N4, Wil 39 Fror.

™ Enatle realtime ISP to allow background programming (for M || devices]

Wb Start |F\Ie ‘Dewce Checksum |Usercude Er;ﬂgﬁr;:’:é Werify E‘:::k E xamine Segti.:nty Eraze CILSATAF'|
led.sof EP2CIEFET2 O02FDEEC FFFFFFFF [m] [m]

b Auto Detect
39 Jtag ARIEFTHRAE
2) R FE T pof XM, HESE R Delete KBS, sof SCAF M Programmer HlIER, X5
siili Add File 1E#¢.pof U, F 5 (Mode) ity Active Serial, W1 40, ¥4 &I 206 H b

B R BT AR AE PRGOIRAS, AR5 riili Start, FEFP#C N33 EPCS .
USB-Blaster [USE-0] Mude_@mgmss I 1%

40 ASAREFTHFAE
2, BEATERN T A TR, /8 HAst ERTLLE 2] LED AT a3 st .
6.2 Signaltap 11 f1#H

Signaltap 11 J& Quartus 11 AR 7B T, o] IS v h b 1 A5 5 RS A T AR 26 R0
76 FPGA R BB o 3 e i 4 34T ff B 41
%+ [Tools] -> [Signaltap Il Logic Analyzer), HELanE 41 FrossdiGHE .

l:a stpl.stp |
@ Ilrwalm JTAG configuration El &
Instance Manager: |Ime\id JTAG configuiation @ X | JTAG Chain Configuration: _ @ x
Instance | Status | LEs: 0| Memory: 0| MS12/LUTRAM: NA |
: auto_signaltap_0 Mot running 0 cells 0bits [ Haidware: [ j Setup...
Device: | -] _seanchain
< 5 _ﬁ] SOF Manager: E
auto_signaltap_0 hj"lllvw all changes Ll Signal Configuration: x
Node ‘Dat.l Enable |Tllnnul Enable I‘rrbgner Condmo...‘ Clock: l l_l /B\‘
|Tywe [Atias| Hame o ] [] [1F Basic -] /
Doubl k to add nods Data B
Sample depth: (128~ | FAM type:
- I™ Segmented:
/ \ Trigger
\ ;,,/ Trigger flow control | Sequential -
Tompodir:  [MPevigmposin 3]
Trigger conditions: 1 -
™ Triggerin
Source: | [ =l
E] Data @ Setup
Hirrathu Nisnlas X I Naalee kR

41 Signaltap Il 5
1. signal configure BT E

HOLIE A Bl Clock, siti& 41 vh B ARRHHL I BLANE 42 Pros i ihtE, £+ [Filter] ->
[Post-fitting], #A )5 xiili List, Nodes Found " ILFTA 45 i, 1E4% clk o JF A, X clk
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ot 5 S AR T R4 Ui 45 B AR R AT R A

IR A RE N Ron ek, st [OK), TR E .

Named: [+ =] Fiter: [SignalTap I postiiting  v|  Customize.. | List | Q ok |
Look in: [T ] .| W Include subeniiies | Cancel |
Modes Found: Selected Nodes:

Mame | Aszsignments A Mame | Ass_iM[_T
< Add1108 Unassigned L5 [led|clk, PIN_M1 It
< Decoder0™144 Unassigned
< Decoder0™145 Unassigned
< Decoder0™146 Unassigned
4 Decoder0™147 Unassigned
¥ Decoder0™148 Unassigned
<& Decoder0™143 Unassigned T
4 Decoder0™150 Unassigned i
< Decoder0~151 Unassigned LI
< Equall~240 Unassigned
¥ Equall~241 Unassigned _SI
< Equall~242 Unassigned il
< Equall~243 Unassigned
4 Equall~244 Unassigned
¥ Equall~245 Unassigned
< Equall™~246 Unassigned
> clk FIN_M1
< clk~clketr Unassigned
T counter Unassigned
4 ¥ < >

E 42 fhEEIRE
Sample depth ZEIHI KL FE R RAT (IRIE, o) DU 7 AT W8, (H2 2075 162 FPGA A
BTGB EO RN, IRV E R ) FPGA AT fil 2 B/ NIZ B B AN R I
2. WM ERERE
TR 41 T A XSO bR A B4 5 i A B B S ABL R0 T AE (I 42D, B BEI) 7 vE—FE,
FEIX FLRRAT T3 U] P 355 12 47 1 state A1 counter, riili [OK] J&[HIF & 43,

trigger: 2006/02/20 16:22:21 #0 | i1low all chenges |
Hode Data Enable [Trigger Enable [Trigger Conditio...|
Type Alias| Hame 27 27 17 [Basic -]
= : [7]- state [~ I~ WM HR ]
[ counter | I OO0

B Dete | Setup |
43 BirERRE
W IR B E DR AT I TREEAT FF i 1%
3. JTAG )&

B N 3B H AR, %) Signaltap 1l F11#) JTAG Chain Configuration £23H47#% & . fitli Setup
1&$¢ USB-Blaster, xiii Scan Chain #94H Hbrésff, #5f5 SOF Manager F11% % led.sof, w1l 44 iy

No
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R S E TR B BT St AR WA

JT4G Chain Configuration: |J TAG ready @ =

Hardware: | USB-Blaster [U5B-0]

Device: |@1:EF’2E35 [0<020B 4000 j Scan Chain
ﬂ SOF Manager: g;,, 1] |Ied.sof J

44 Jtag EEEE
Z5ERC T Signaltap fFTA K E .
4. MEBEA
Aiili Instance Manager #%1 ", XIHE2 R state A1 counter PANE B SRR .
45 JIT 7K

B | e o | -8 &8 % (]
Instance Manager: Fi |F!ead_l,l b0 acquire @ X | JTAG Chain Cc
Instance | Statis | LEs:778|  Memon: 55296 | MS12/LUTRAM: 0
E auto_signaltap_0 Mat running 778 cells 55296 hits 0 blocks Hardvare: m
Device: |—@
2 5| | SOFMa
log: 200809029 16:47:25 #0 click to insert time bar
Type Alias| Hame ||405 4DIB 4DI? 4D|8 40|9
e [ state h
= [ courter {  BARCCCh % SARCCDR % SABCCERW  f  SARCCFh L SARCDOR

45 MEZEMNEEFO
6.3 {ET.E ModelSim f1#H
Modelsim /& MenterGraphics 2 w4 H I —Fh 5 5, DhRess KA 0 1 T R XX Eif
() led_core.v BEATACHE AT FLR B 44 ModelSim fAE ] . ACHS 07 ELTRZEAI LR =AM 8650
1. HehR ¥t AaY, VHDL i 5 8 Verilog i 5 2.
2. WMRRBPIARIS, Bk Test bench, BHUSNBIEN, BIAIEA, BHEMSE, XLCLEJ7 IR
fix H e @ i test bench k=7 .
3. U ELBIAPE MRS TE A TR AR A N S A R i, w1 Altera $RAR IR PLL,
Buffer £,

ModelSim fUHE 45 ZD R U
6.3.1 ModelSim {FE 352

1) BT

riddi [File] -> [New] -> [ Project), iX}4: I Create Project 1% I, il 46 fiTz~. {E Project
Name A2 -PE 500 H 445, @EBCRRINTIZ SO 44730, X HL¥K test. Project Location 4i5& T/
H3%, nliEid Browse 141 ki # 0k 2s . Default Library Name ] LK T 2R A1) work.

41



N

A5 2 AT Y

o

UL A5G R B B A 7]

ﬁ Create Project

Project Mame
|test

Project Location
D Falteras quartusleddsim Browse...

Default Library Mame

[

Copy Settings From
|D: £alterasmodelzim /modetsim, ini Browse...
* CopyLibrary Mappings ¢ Reference Libramw Mappings

Ok Cancel

46 Modelsim Ti8#EL

2) s
ModelSim £x 4 )3t LED Items to the project % 1, 43 TREIMASCHE, il 47 Fiows.

Add items to the Projeck |

r— Click on the icon to add items of that twpe:——

] ]

Create Mew File Add Ewxisting File
Create Simulation Create New Folder

47 XHEARMA®E

1EF¢ LED Exsiting File &, HR4EAH N HE58 SCAF In21i% Project /1, 3 HL AR AN ST B A SC
fF led_core.v (&l 48) FIARELJih testv (K 49), HAARFUIIR.

“timescale 1ns/ 1ps
module led_core( clk, reset ,led );
input clk, reset;
output [7:0] led;
reg [3:0] state;
reg [22:0] counter;
reg [7:0] led;

always @(posedge clk)
if('reset)
counter<= 23'h0;
else

counter<= counter+1,;

always @(posedge clk)
42



A5 2 PARTT 1 6 WS AEBGH KR R AT R )

if('reset)
state <= 4'b1000;
else
if(counter == 0)
if( state<= 7 && state>=0)
state <= state - 1;
else
state <= 4'b0111;

always @(state)
case(state)
4'b0000 : led = 8'b1111_1110;
4'b0001 : led = 8'b1111_1101;
4'b0010 : led = 8'b1111_1011;
4'b0011 : led = 8'b1111_ 0111,
4'b0100 : led = 8'b1110_1111;
4'b0101 : led = 8'b1101_1111;
4'b0110 : led = 8'h1011_1111;
4'b0111 : led = 8'b0111_1111;
default : led = 8'b1111 1111;
endcase

endmodule

48 led core.v JE55

“timescale 1ns / 1ps
module test();
reg clk,reset;
wire [7:0] led;
led_core led_core( clk, reset ,led );
initial begin
clk =0;
reset = 0;
#1000 reset = 1;
end
always #1 clk=~clk;

endmodule

49 test.v JEFRG

3) ZRiF
fiit [Compile] —> [Compile ANY X LL R SCPEREA T e, 40 300 7 SCp A 3
status 228, WK 50 Fs. G AN T ) 75 R A T 5 2 03 ok A R AT

a1k
7D
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File Edit ¥iew Compile Simulate #Add Source 1

v J ¥ay

i
e
by
M

“Workspace Y H
1'1Name _\|Statul Type |Elr|:|e|h-1|:u:|ifieu:|
led_core.w { Werlog 1 09429/
best. v « Merlog 0 09/29/00

50 IXiH4RiF
4) g
Aiy [Simulate) -> [ Start Simulate), 2> H 3 Start simulation T iEHE. @1 51 7, & work
H s FIERETIZE SO test, il OK.

l[,=,'_|I Start Simulation

Desian | YHDL | Verlag | Libraries | SDF | Others | P
"'IName |Ty|:|e |F'ath =
-HNL ok Library work,
M ot Optimized...
] led_core Maodule [ /alteradquartus,led/led_core.w
Module  D:/altera/quartusded/test v
sl svstd Library  $MODEL_TECH/./sv_std
i,m wital2000 Library $MODEL_TECH/.. Avital2000 1
] ieee Library  $MODEL_TECH/.fiees
1}{‘1 madelzin_lib Library FMODEL_TECH/ .. /modelzim_lib
i) | lihears  #MONFI TFCHY fstd ~|
4| | B
Dreszign Unitfz) Resolution
|work.lest |defau|t !I
Optirnization
[ Enable optimization
CTHET] Cancel |

51 MRSk

IX I E workspace | HYE instance HE, U1K 52 fis. 4 £E test I ik Slbn A, 76 Add 3E0
Hik$E Add to Wave. SXFELE( FLAT G 23 s T SLE .
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B 5 2 AR TE R S S U B B AR R AT R A

(] ModelSim SE PLUS 6. 2h

File Edit ¥iew Compile Simulate Add Structuwre Tools Layout Hindow
T Pl j 4 ew FF welEEIR I BPRY
MG S

Objects K

"Ilnstance |Design urit |De

o HINITIZ Prel i+ Jed HERER R

+ gl led co iew Declaration Mc
E Add All Signals to Wave

SRR Add

Create W ave Add to wave
T Add o D.ataflcuw
. Add to List

Find.. Add to Watch

Erpand Selected
Collapze Selected
Expand Al
Collapze All

52 KRN

IXIAE [Simulate] -> [run —all] £, JF405 5, TSR T 1) Break 35 n] Afd () BL45
1he PiEEW)E, {F Wave & H HE S HBUT AT, Wik 53 Fis.

Log

1
1

[URRRAR [ ERNNEN]

53 {REKK
4., FEGESHHRE
Wave % I 5 B3, ] DURAFECR UGN . 348 File 29 R Save format, fRA7
B wave.do (1. Wil 54 fias, FEEAR, 76 modelsim iy 24T WFAT AT 4 do wave.do BIA] .

ﬁ S5ave Format
Pathriarmne

[i: Aalterad quartus Aed simdwave. do Browse. ..

Save contents

[ waveform formats

-

0k | Cancel

54 R RTE
6.3.2 fA Altera BHMHERE

1) k3 modelsim (1) 235 H 5% F 1) modelsim.ini SCF,  BUH e 1) - i3 g 1
2) 4777 modelsim, 7£E% 1i%E+#% [File] — [Change directory ), ¥ TAF H 5% 250728 SR AAE L
D FER H %, Al OK. X HLE ¢ modelsim )22 FH 5%, U1Kl 55 Fizs.
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( Chooze" folder 1

i
Lo

+ examples
include
perl_sreo
qvl_sre

tel
veriloz_sre
vhdl_sre
win32

“HBEBOEED

BoE
P )
2zs

4 ol

Directony path
|0 alkerat odetsim

B 55 R&{ZYIHR

3) e OhksE [File] — [New] — [Library]) #ir4 73 H! ) [ Create a new library] %
eI [Create] ¥ & [anew library and a logical mapping to it] ,7 [ Library name]
A1 [Library physical name] 8 A B 226 it 12 44 77 altera_lib, 11| 56 Jr7, I I 7 3 % H
C.% 7 altera_lib i,

Create

* anew library and a logical mapping to it

(" amap to an existing libram

Library M ame:
|altera_lib

Library Physical Mame:
|a|tera_lib

ak. Cancel

B 56 €IEZHE

4) At Workspace (] Library ik R8I K% altera_lib, 7F 3¢ #.741i% [ Compile] —
[ Compile---] ;#E5 Hi % 11 compile source file % 1R[] [Libaray] T3 8 i fp AR 1K) 22
A0 [AEHRIEE T Hk$e quarturs ¢34 H s\quarturs\eda\sim_lib SC{JE R X &1 8 AN
HEAT Y PE T T B PP IR, R IpE RSB IE X 8 /N30, midhi [Compile] X4y A,
SEE PRl [Compile] |, Zwidiksh, fithi [Donel, Wil 57 Fiox.
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5) % Ml Modelsim ,

Compile Source Files

Library: |a|lera_|\b LI

FHIEE L) |3 sin_Lib - « =F EE-
[kl alters ng 87 N
altera_mf_components a

un]220madel BT [it)alters primitives B

[hl220pack [alters primitives [uail=

Jaltera mf [wilalters primitives_conponents [wis

Uh]altera mf [ut] apex20k_stoms [amls

S0 w | B

itEm@: | Canpile |
THZER (D) [MIL Files 6k vk vlik vhiik vhdlix v v | —— |

I~ Compile selected files together Default Options. | Edit Source |

R
m

B 57 PEEHY%RiF

Ji T 0 31 Modelsim , 40 B iX Bf Workspace P OH IR
“altera_lib(unavailable)”, XI5 245 7E altera_lib [f1#54%, 1 altera_lib ElFs ko A7 Bk

F£ [edit] #55¢ altera_lib W42, Wikl 58 fFix.

6) i KF modelsim.ini ) ME F T Ok e IXFEER RS ] Modelsim 477 B4 5 A FXF Altera

PEMEATE T .

7 EREBEARE

al _|
ﬁm s_std Library  $MODEL_1
ﬁm wital2000 Libray  $MODEL_1
ﬂi.‘ll ieee Libray  $MODEL_1
;H]l modelsim_ib Library  $MODEL_1
=] = Library  $MODEL_1
] e developerskit Library  $MODEL_1
] swepsys Ly $MODEL_T
w{] verioa Libiary  $MODEL_T
Iﬁ'}:dit Library Napping =
Mapping Name
Library Pathname ——————
D/ alteraModeksim/alers_lib
Browse.
- OK | Cancel
1o alal

B 58 fERERFRIERTE

7.1 RHARTIELL ITAG HFR T HIEF?

D HARIECZT T

2) A USB 2k C 48 IF R4k,
3) R I (J15) Ab{E RUN IRZ.

7.2 WP ABIIELL AS T T HEF?

D HARIEC 2T

2) A USB 2k C48 IF R4k,
3) WINEATITFIE (J15) AbAE PRG KA.
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5 5 % AR TT R4 U i 3 BTG K RHE A A A

7.3 A4 B OTEITEER?

D Wl D IEERE, ERRL L,
2) HAINHE A 52 HOE 15 IR
3) BB R A DAL T EHARAS .

8 HTEFRIEH

8.1 OB

1. LED WA
a) T /NFERP: DEA4.2_coremodule_ledtest OK.
b) NP EHEE I
c) W RACR: BRI LED A R SR
2. uCLinux JARFL 7
a)  HNFET:
b) IR ER:
i WUREER T, BERGENA S RS ket Flash ;. W Flash #(5id, 2%
SR FRR A EDRT T BN A S RS

i R ER L.

ii. TP A, %NS
PR 115200 W5
EAE A 8 {1
(ERIRDA 147
AR o
i G

iv.  WURTFEAELUKM, KM L HHEHL IP W 192.168.1.237 (RO L IP
CLHAE BN 192.168.1.236) .
V. FTIFRZOBR FIE TR 2 NIOS.
c) VAR
MBS 2ty br] LA B uCLinux 1E5 8, P Al DUSSEHAT & Fhdr £
i A: root; #hS: uClinux
A[ LA ping 192.168.1.236 AN M 45 & 15 1E 0

8.2 ¥ ERREI EF

1. Rtk USB iy
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a) FifF: DE4.2_USB_OK
b) ZFHi%H K N readme.txt
2. IR AV il VGA FEIT
a) VH/NFERP: DE4.2_tv_av2vga ok
by #&ERK: NTSC HIM AV i %% (DVD #iay) —4, VGA O ERd—14.
c) AR
i. ¥ DVD FEAR ) AV iR R YRR AV BN
i, ¥ VA BURSHE NZOE Y R LI VGA i1
i, AT R &
d) ZR: VGA RN AV FIATKIN A
3. NI 4%4 F A 8 A )\ BLBUS & R
a) JHURFERP: DE4.2_key and display;
b) EIRACR: HHEE TR
C) HURACR: N MR, \BUEUYE IR s AL s W os AR A B
4. TSR T
a) VH/NFER: Ded.2_test_key hex
b) EIRACR: R TR, \BOSRSE TS AW 2.
5. FHOARBBIITRA LED AT FEfP
a) VH/NFER: DE4.2_test_led sw
b) AR BRI
C) URZUR: LY REMCKIBEN TT AT Lo s — A LED 4%, BahIT AT LK, 1R
TR
6. NIIARE E TR
a) VH/FERP: DE4.2_LCD_logo OK;
b) AR EAEE R
C)  EHURACR: IR R EEE bR R R AN, JEEERY)” LA

9 Mi

BERGM TR,
F24 MY

4 Ko

MU 14

AW 13 (B 59(a))
R CrTgEf) 13 ( 59(b))
HL Y8 14 (E59(c)
%5 14 (J59(d))
CENEIBIRED 14 (K 59(d))
—EFR D2 (T I 14 (B 59(f)
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&

BUF 5 BT )

PGERY 1A

YDA 15K

(b) %R+ AR
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(c) HLYH

A5G R B B A 7]

(d) F#k

(e) %Lk
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(H Hrk
59 FELMY

10 MR

[1] & sk

[2] Ot 2

[8] ¥ et FE A

[4] et

[5] uClinux-v1.4.1, F7E NIOS Il L[] uClinux
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